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Warranty and liability 
 

Note The Application Examples are not binding and do not claim to be complete regarding the 
circuits shown, equipping and any eventuality. The Application Examples do not represent 
customer-specific solutions. They are only intended to provide help for typical 
applications. You are responsible for ensuring that the described products are used 
correctly. This Application Example does not relieve you of the responsibility to use safe 
practices in application, installation, operation, and maintenance. By using this Application 
Example, you recognize that we cannot be made liable for any damage/claims beyond the 
described liability clause . We reserve the right to make changes to this Application 
Example at any time without prior notice. If there are any deviations between the 
recommendations provided in this Application Example and other Siemens publications – 
e.g. catalogs – the contents of the other documents have priority. 

We do not accept any liability for the information contained in this document. 
Any claims against us – based on whatever legal reason – resulting from the use 
of the examples, information, programs, engineering and performance data etc., 
described in this Application Example shall be excluded. Such an exclusion shall 
not apply in the case of mandatory liability, e.g. under the German Product Liability 
Act ("Produkthaftungsgesetz"), in case of intent, gross negligence, or injury of life, 
body or health, guarantee for the quality of a product, fraudulent concealment of 
a deficiency or breach of a condition which goes to the root of the contract 
("wesentliche Vertragspflichten"). The damages for a breach of a substantial 
contractual obligation are, however, limited to the foreseeable damage, typical for 
the type of contract, except in the event of intent or gross negligence or injury to 
life, body or health. The above provisions do not imply a change of the burden of 
proof to your detriment. 

Any form of duplication or distribution of these Application Examples or excerpts 
hereof is prohibited without the expressed consent of the Siemens AG. 

 

Security 
infor-

mation 

Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks. 

In order to protect plants, systems, machines and networks against cyber threats, it is 
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 
security concept. Siemens’ products and solutions only form one element of such a 
concept. 

Customer is responsible to prevent unauthorized access to its plants, systems, machines 
and networks. Systems, machines and components should only be connected to the 
enterprise network or the Internet if and to the extent necessary and with appropriate 
security measures (e.g. use of firewalls and network segmentation) in place.  

Additionally, Siemens’ guidance on appropriate security measures must be taken into 
account. For more information about industrial security, please visit 
http://www.siemens.com/industrialsecurity.  

Siemens’ products and solutions undergo continuous development to make them more 
secure. Siemens strongly recommends to apply product updates as soon as available and 
to always use the latest product versions. Using versions that are obsolete or are no 
longer supported can increase the risk of cyber threats.  

To stay informed about product updates, subscribe to the Siemens Industrial Security 
RSS Feed under http://www.siemens.com/industrialsecurity. 

 

http://www.siemens.com/industrialsecurity
http://www.siemens.com/industrialsecurity
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Preface 

Objective 

This document describes the steps which should be carried out for the installation 
and setting up of the Process Historian (PH) and the Information Server (IS) within 
a PCS 7 environment. 

It also explains the commissioning procedure for the PH and IS as well as 
instructions for system checking and troubleshooting. 

Core contents 

The following topics will be discussed in detail: 

• Installation requirements 

• Installation of the Process Historian 

• Installation of the Information Server 

• Installing of the Operator Station 

• Commissioning of the systems after installation  

• Scenarios and instructions for system checking and troubleshooting 

Validity 

This document is valid for the following components: 

• SIMATIC PCS 7 V8.2 

• Process Historian 2014 SP2 

• Information Server 2014 SP2 
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1 Introduction 

1.1 Overview 

This application example is based on the following PCS 7 architecture: 

 

Figure 1-1: Overview of the installation structure 

 

 

PH used / IS hardware used in this example 

• Fujitsu Primergy Server RX2560 M1 

• Server 2012 R2 Standard, 64 bit 

• 64 GB SDRAM 

• 2 x 300 GB 2.5-inch SAS 12 GB/s HDD 

• 4 x 600 GB 2.5-inch SAS 12 GB/s HDD 

• 16 x 1.2 TB 2.5-inch SAS 12 GB/s HDD 

• Redundant power supply 

The document describes the installation of a 2014 SP2 Process Historian on a 
Fujitsu Primergy Server RX2560 M1. It examines the configuration of the RAID 
system and the installation. 

For further information about the Fujitsu Primergy Server RX2560 M1 please see 
the following manual on the Fujitsu website: 

https://sp.ts.fujitsu.com/dmsp/Publications/public/ds-py-rx2560-m1.pdf 

 

https://sp.ts.fujitsu.com/dmsp/Publications/public/ds-py-rx2560-m1.pdf
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Source: www.fujitsu.com 

 

Note The description is also valid for the Process Historian / Information Sever 2014 
SP2 Update 1 and Update 2. 

 

http://www.fujitsu.com/
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1.2 PH / IS Installation sequence on a Fujitsu Primergy 
Server 

Requirements 

For the installation you require 

• the hardware and software described in Section 1.3. 

• Adequate Know-how in the handling of SIMATIC PCS 7, PC hardware 
configuration, RAID systems and software installation. 

Installation sequence 

Note the following installation sequence for installation: 

1. Configuration of the RAID system 

2. Installation of the operating system 

3. Installation of the components necessary for operation 

4. PH / IS Software Installation 

5. Installation of the database 

1.3 Components used 

The Application Example has been created with the following hardware and 
software components: 

Component Quantity 

Fujitsu Primergy Server RX2560 M1 1 

Process Historian 2014 SP2 1 

Information Server 2014 SP2 1 

 

The following assumptions on system configuration apply to the sample application: 

System characteristics Value 

Number of connected OS servers 3 

Measurement value: Load per OS system 1500 Measured values/s 

Alarm messages, Load per OS system 5 alarms/s 

Online availability of data 2 years 

Use of SIMATIC BATCH Yes 

 

Based on the assumptions concerning the system configuration, the following load 
results for the Process Historian: 

Total Measurement value Load:  

1500
𝑀𝑒𝑎𝑠𝑢𝑟𝑒𝑚𝑒𝑛𝑡 𝑣𝑎𝑙𝑢𝑒𝑠

𝑠
∗ 3 𝑆𝑒𝑟𝑣𝑒𝑟 = 4500

𝑀𝑒𝑎𝑠𝑢𝑟𝑒𝑚𝑒𝑛𝑡 𝑣𝑎𝑙𝑢𝑒𝑠

𝑠
 

Total Alarm messages Load:  

5
𝑀𝑒𝑠𝑠𝑎𝑔𝑒𝑠

𝑠
∗ 3 𝑆𝑒𝑟𝑣𝑒𝑟 = 15

𝑀𝑒𝑠𝑠𝑎𝑔𝑒𝑠

𝑠
 

 

Note The system described is intended for combined operation of Process Historian 
and Information Server. 
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2 Installation requirements 
 

Process Historian and Information Server can be installed on a single device or 
on two different ones. If PH and IS are installed on the same computer, both the 
installation requirement and the necessary adjustments must be given. 

In this application example it is assumed that the PH and IS are installed on the 
same computer. 

 

Note The requirements for installing the PH must be met. The corresponding 
requirements are listed in the "INSTALLNOTESPRHIDEDE.chm" documents. 

The Install Notes can be found on the Product DVD in the folder  
“<DVD Drive>:\DVD_1\27b_PH+IS_Install_and_Release-Notes\German". 

 

Note The requirements for installing the IS must be met. The corresponding 
requirements are listed in the "INSTALLNOTESINFSVDEDE.chm" documents.   

The Install Notes can be found on the Product DVD in the folder  
“<DVD Drive>:\DVD_1\27b_PH+IS_Install_and_Release-Notes\German". 

 

NOTICE The computer SID is a unique security identifier. The Process Historian 
identifies the OS systems from their computer SID. 
Computers that have the same computer SID and swap data onto the PH, 
cannot be clearly identified by the PH. This may cause malfunctions on 
the PH. 

If computers are cloned, the computer SID is not adjusted automatically. 

In the PCS 7 environment, unique computer SIDs are a requirement for 
error-free functionality. 

The PH/IS machine, too, needs to have a unique SID. 
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2.1 Installation requirements for the Process Historian 

The following installation requirements must be met: 

• Windows Server 2012 R2 (64-bit) Standard / Enterprise or Windows Server 
2008 R2 (64-bit) Standard / Enterprise 

• Microsoft SQL Server 2014 SP1 64-bit. 

The SQL Server is automatically installed when the Information Server is 
installed. 

• The Process Historian requires the "Microsoft Message Queuing" service. 

• The computer must have enough free storage space available for the 
installation of the Process Historian. 

• As part of the PH installation, Microsoft NET Framework 4.0 is also installed. 
The setup program checks to see if version 3.5 of Microsoft.NET Framework is 
available. 

Microsoft.NET Framework 3.5 must be installed prior to installation of the PH 
and the IS. 
 

Note Process Historian is a long-term archive. The hard disk space required can be 
high, depending on the alarm and tag load together with the period to be saved. 

Use hard disks with a sufficiently large capacity. 

 

2.2 Installation requirements for the Information Server 

The Information Server can be installed on different systems.  

All the suitable Microsoft operating systems and software components are listed in 
the following table: 

Table 2-1 

Operating system Configuration Remarks 

Windows 7 Professional SP1 

Enterprise SP1 

Ultimate SP1 

Standard installation 

32-bit and 64-bit 

Windows Server 2008 Standard SP2 32-bit 

Windows Server 2008 R2 Standard SP1 64-bit 

Windows Server 2012 R2 Standard 64-bit 

 

• The Information Server requires the "Internet Information Services" (IIS) service. 

• As part of the PH installation, Microsoft.NET Framework 4.0 is also installed. 
As the setup program checks whether the previous 3.5 version is available, 
Microsoft.NET Framework 3.5 must be present before installing the PH and 
the IS. 

• Visual Studio Tools for Office (VSTO runtime) 

• Microsoft SQL-Server 2014 SP1 64-Bit. The SQL Server is automatically 
installed when the Information Server is installed. 

• The Internet browser used must support HTML5. 
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Table 2-2 

Product Version / Comments 

Internet Explorer As of version 11 

Mozilla Firefox Latest version 

Google Chrome Latest version 

2.3 Installation requirements for the IS client 

2.3.1 Requirements for the Internet Explorer IS client 

• Operating systems, see Information Server 

• The Internet browser used (see table) must support HTML5. 

Table 2-3 

Product Version / Comments 

Internet Explorer As of version 11.0 

Mozilla Firefox Latest version 

Google Chrome Latest version 

2.3.2 Requirements for the Office IS client 

• Operating systems, see Information Server 

• Microsoft.NET Framework 4.0 

• Information Server Office add-in (the Office add-in requires the VSTO runtime) 

• Visual Studio Tools for Office (VSTO runtime)  
MS Excel (32 bit) and VSTO form the basis for the Information Server 
MS Excel Add In. 

VSTO is located in the folder “R:\27_InformationServer__V8.2\VSTOR" of the 
PCS 7 DVD 2 

 

Note The VSTO component from the PCS 7 general setup is automatically installed if 
the components setup "Information Server - MS Office Add-in 2014" is selected 
in the user-defined installation. 
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Note The PCS 7 setup automatically installs the correct version of Microsoft.NET. 

If you do not install the Information server Office Add In with the PCS 7 setup, 
you must install Microsoft.NET Framework manually. 

You will find Microsoft.NET Framework 4.0 on the PCS 7 DVD1/2 under the 
path: "08_DotNetFramework\ NDP451-KB2858728-x86-x64-AllOS-ENU.exe". 

Alternatively, you can download Microsoft.NET Framework 4.0 at the following 
link: 
http://www.microsoft.com/en-US/download/Details.aspx?id=17718 

 

Supported Office versions: 

• Microsoft Office 2007 SP3 (32 bit) 

• Microsoft Office 2010 SP1 (32 bit) 

• Microsoft Office 2013 (32 bit) 

 

http://www.microsoft.com/en-US/download/Details.aspx?id=17718
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3 Server configuration 
The hardware selection and the implementation of the RAID configuration are 
described in the following. 

 

NOTICE Before you can install the Process Historian / Information Server, the RAID 
system must be fully configured.  

This operation may take several hours. 

3.1 Calculation of the HW requirements with the PH HW 
Advisor 

You can determine hardware suitable for your system and quantity structure with 
the help of the Siemens tool “PH-HWAdvisor”. 

 

Note In the application example “Determination of suitable hardware for the 2014 
Process Historian with the tool “PH-HWAdvisor” you will find a download link and 
instructions on its use at: 
https://support.industry.siemens.com/cs/ww/en/view/109740115 

 

Note If you need assistance with the choice of appropriate Process Historian 
hardware, please get in touch with your SIEMENS contact. 

 

https://support.industry.siemens.com/cs/ww/en/view/109740115
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For the assumed system characteristics from section 1.3 a calculation was carried 
out with the “PH-HWAdvisor“ tool. The following image shows an example of the 
calculation in the PH-HWAdvisor.  

 

For the application example a hardware configuration was used which provides a 
performance comparable or superior to the minimum requirements determined by 
the tool. 
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3.2 Hardware RAID configuration 

The server architecture allows the RAID system of the Fujitsu Primergy Server Size 
M to be freely configured. 

The following hard disk and RAID configuration is used for the quantity structure of 
the application example: 

• Configuration with 22 hard disks 

• RAID1 configuration 

• RAID10 configuration 

 

The hard disks have the following designation and tasks within the Process 
Historian: 

RAID Drive 
name 

Size Name  Data  

RAID1-1 C: 600 GB Operating system Operating system 

RAID1-2 D: 1.8 TB TagGroup0 Runtime Data Group 0, 
Compressed Data Group 3 

RAID1-3 E: 1.8 TB TagGroup1 Runtime Data Group 1, 
Compressed Data Group 0 

RAID1-4 F: 1.8 TB TagGroup2 Runtime Data Group 2, 
Compressed Data Group 1 

RAID1-5 G: 1.8 TB TagGroup3 Runtime Data Group 3, 
Compressed Data Group 2 

RAID1-6 H: 1.8 TB IS DB Information Server DB 

RAID1-7 I: 600 GB CommonData Configuration data, General 
database data  

RAID1-8 J: 1.8 TB TLog Transaction logfile 

RAID1-9 K: 1.8 TB Batch file SIMATIC BATCH data 

RAID10-1 L: 3.6 TB Alarms / 
Messages 

Alarms and Operator 
Messages 

 

All the hard disks are accessible from the front side of the server. Install the hard 
disks in the logical sequence of the RAID configuration. 

For the RAID1 configuration all the hard disks are installed one next to the other. 

 

 

Note The number of RAID1 hard disks determines the capacity of the Process 
Historian. 
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3.3 Software RAID configuration 

You must carry out the RAID configuration of the server hard disks before you can 
install the operating system and Process Historian. 

The Fujitsu Primergy Server is delivered with software for the RAID configuration: 

• DVD "Servers View Suite – Installation" 

• DVD “Operating System – Recovery DVD Windows Server 2012 R2 Standard” 

• DVD "Server View Suite – Management and Serviceability” 

 

 

 

The software configuration of the RAID system is divided into several parts. These 
parts are described in the following sections. 
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3.3.1 Initialization 

1. Insert the “ServerView Suite Installation” DVD in the DVD drive. 

2. Press “F12” while the system is booting in order to access the boot menu. 

 

3. Select the DVD drive as boot device. 

 

 

4. Select the option “ServerView Installation Manager (WinPE64) [HW conf. and 
OS inst.]”. 



3 Server configuration 

 

PH-Installation auf Fujitsu Primergy Server 
Entry ID: 66579062,    V2.0,    07/2017  18 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

7
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

 

 

5. Click on the “English” button. English is selected as the language. 

 

Initialization “Setting up platform infrastructure” is executed. 

This can take several minutes. The dialog window then opens for further 
installation settings. 

 

6. Select the following installation settings: 



3 Server configuration 

 

PH-Installation auf Fujitsu Primergy Server 
Entry ID: 66579062,    V2.0,    07/2017  19 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

7
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

– Keyboard layout: “US – International”  

– Session mode: "Standard mode" 

– If necessary, deactivate the “Connect status media and/or installation 
media via network” option box 

7. Click the "Continue" button to complete the installation. 

 

Result 

“Initialization and registering of Browser components” is executed. This can take 
several minutes. 
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3.3.2 Start RAID configurator 

1. Click on the "Maintenance” button. 

 

2. Click on the "ServerView RAID” button. 

The “ServerView RAID Manager” menu opens. 

 

 

3. In the hardware overview list, right-click on “PRAID EP420i (0)” and select the 
option "Create logical drive…". 
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4. Confirm the dialog window “Write Access needed!” with “Yes”. 

The dialog window “Create logical drive: PRAID EP420i (0)” opens. 
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3.3.3 RAID1 configuration for the operating system 

Note For the RAID configuration observe the selection of the correct hard disks and 
their capacity according to the assignment in section 3.2. 

 

Note Generating the RAID system takes several minutes. You can shorten the time by 
configuring all the RAID systems at the same time. The RAID systems are 
generated in parallel. 

Configuration of the hard disks for the operating system 

1. Select the first hard disk (1:0) in the hardware list. 

2. Select "RAID-Level" "RAID-1” from the drop-down list. 

3. Select “256 (kB)” as block size in the drop-down list. 

4. Select “Use maximum capacity” as hard disk size. 

5. Select the following settings in the "General parameters" field: 

– Name: "OperatingSystem" 

– Init mode: “Fast initialization” 

– Emulation type: “Default” 

6. Make the setting “Data protection” in the "Cache settings” drop-down list. 

7. Click on the "Add" button. 

3

4

2

5

6
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8. Select the second hard disk (1:1) and carry out steps 2 – 7 once again. 

 

The hard disks (1:0) and (1:1) are prepared for the RAID1 configuration of the 
operating system. 

 

9. Click on the “Create” button. 
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10. Enter “yes” and click on the "OK" button. 

 

The RAID1 configuration for the operating system is initialized. 

 

3.3.4 RAID1 configuration for the archive data 

Note Generating the RAID system takes several minutes. You can shorten the time by 
configuring all the RAID systems at the same time. The RAID systems are 
generated in parallel. 

 

For the archive data repeat the steps from section 3.3.2  for all the hard disk pairs 
of the RAID1 configuration. Your hardware configuration according to section 3.2 
will show you the corresponding hard disk partner. 

 

1. Select the first hard disk of the hard-disk pair in the hardware list that is used 
for the respective RAID1 configuration.  

2. Select "RAID-Level" "RAID-1” from the drop-down list. 

3. Select “256 (kB)” as block size in the drop-down list. 

4. Select “Use maximum capacity” as hard disk size. 
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5. Select the following settings in the "General parameters" field: 

– Name: Designation according to the list in section 3.2 

–  Init mode: “Fast initialization” 

– Emulation type: “Default” 

6. Make the setting “Data protection” in the "Cache settings” drop-down list. 

7. Click on the "Add" button. 

8. Select the second hard disk of the pair and perform steps 1 – 7 once again. 

 

The hard disk pair is prepared for the corresponding RAID1 configuration. 

 

9. Click on the “Create” button. 

10. Enter “yes” and click on the "OK" button. 

11. Wait for the RAID configuration to be generated. 

Result 

The RAID1 configuration for the archive data hard disk pair is initialized. 

 

3.3.5 RAID10 configuration for the message data 

A RAID10 configuration is used for the Message archive. 

For this purpose, combine four hard disks into a RAID10 configuration. Your 
hardware configuration according to section 3.2 will show you the corresponding 
four hard disks. 

1. Select the first hard disk in the hardware list. 

2. Select "RAID-Level" "RAID-10” from the drop-down list. 

3. Select “256 (kB)” as block size in the drop-down list. 

4. Select “Use maximum capacity” as hard disk size. 

5. Select the following settings in the "General parameters" field 

– Name: "Alarms" 

– Init mode: “Fast initialization” 

– Emulation type: “Default” 

6. Make the setting “Data protection” in the "Cache settings” drop-down list. 
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7. Click on the "Add" button. 

 

8. Perform steps 1 – 7 for the remaining three hard disks. 

9. Wait for the RAID configuration to be generated. 

 

The four interconnected disks are ready for RAID10 configuration. 

 

10. Click on the “Create” button. 

11. Enter “yes” and click on the "OK" button. 

 

12. Wait for the RAID configuration to be generated. 

The RAID10 configuration for the Message archive is initialized. Upon completion 
of the initialization of all RAID configurations, the server is ready for the installation 
of the operating system and Process Historian. 
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3.4 Installation of the operating system 

Important notes on the installation 

• Do not use the name "HIST" or "HISTORIAN" for the PH computer because it 
is already pre-set for the SQL Server instance. If you should assign this name 
to the PH computer, this will cause a conflict with the SQL server and the 
database assistant will not function. 

• Do not use the name "NFSERVER" for the IS computer because it is already 
pre-set for the SQL Server instance. A double assignment of the name will lead 
to function disruptions. 

• In the course of the installation of all PCS 7 devices, the administrator should 
always have the same username and the same password. 

 

NOTICE The Process Historian 2014 and the Information Server 2014 are approved 
for use in both the PCS 7 and WinCC environments. 

Only the PCS 7 documentation applies with regards to the installation 
requirements in the PCS 7 environment. 

The installation requirements differ from the PCS 7 installation 
requirements. 

The installation requirements for PH/IS can be found on the product DVD 1 
in the path: "<DVD drive>: 27b_PH+IS_Install_and_Release -
Notes\German\InstallNotesPRHIdeDE.pdf".  

 

3.4.1 Initialization 

1. Insert the “ServerView Suite Installation” DVD in the DVD drive.. 

 

 

2. Press “F12” while the system is booting in order to access the boot menu. 
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3. Select the DVD drive as boot device. 

 

 

4. Select the option "Server View Installation Manager (WinPE64) [HW conf. and 
OS inst.]". 
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5. Click on the “English” button. English is selected as the language. 

 

 

Initialization “Setting up platform infrastructure” is executed. 

This can take several minutes. The dialog window then opens for further 
installation settings. 

 

6. Select the following installation settings: 

– Keyboard layout: “US – International” 

– Session mode: "Standard mode" 

– If necessary, deactivate the “Connect status media and/or installation 
media via network” option box 

7. Click the "Continue" button to complete the installation. 
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Result 

“Initialization and registering of Browser components” is executed. 

3.4.2 Selection of operating system 

1. Click on the “Deployment” button to start the installation dialog. 

 

 

2. Activate the "Customized" check box and click on the "Next” button. 
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3. Activate the “Create a new configuration file” check box. 

4. Select the following options in the four "Select the Operating System" drop-
down lists: 

• "Windows" 

• “MS Windows Server 2012 R2” 

• “Windows Server 2012 R2 Standard”  

• “(first release)” 
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5. Deactivate the option box “Edit Server Management Settings”. 

 

 

6. Click on the "Next” button. 

Result 

The installation pre-settings have concluded and the dialog changes over to the 
settings for the partitioning of the hard disks. 

3.4.3 Defining the operating system partitioning 

The RAID system to be used for the operating system is chosen in this dialog. The 
basic setting for this is hard disk 1. 

If you wish to install the operating system on a different hard disk, use the “Remove 
Partition” button for hard disk 1. 

Select a different Hard Disk Drive for the operating system using the “Add Partition” 
button. 

 

Note The “Add Partition” and “Remove Partition” buttons change the choice of 
operating system partition but do not modify any partition settings. 

 

The Fujitsu Primergy Server type is detected automatically.  

1. Select "Configuration > Mass Storage > Configuration" in the tree. 
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2. Select the RAID1 configuration via "Remove / Add Partition" that is to be used 
for the installation of the operating system. 

 

3. Open the drop-down menu of the hard disk selected. To do this, click on the “+” 
button. 

4. If necessary make the following settings for the partition: 

• Label: "system" 

• File system: “NTFS” 

• Partition size: at least 50GB 

• Quick Format: "Yes" 

• Partition usage: Select option boxes “Boot” and “OS” 

5. Confirm the settings with the “Apply” button. 

 

 

6. Click on "Next". 

Result 

You have finished making the partition settings to install the operating system. 
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3.4.4 Operating System Settings 

Basic settings 

1. If necessary, activate the following option fields: 

• Type of installation source medium: "Fujitsu OEM” 

• Type of installation: "Full” 

• Setup language: "English” 

2. Click on the "Next” button. 

 

 

3. Define the basic settings for Windows: 

• User name: e. g. "Administrator" 

• Organization: e.g. Company name of customer 

• Computer name: e.g. "PH01" 

4. Create an administrator password. 

5. Make the time zone, regional and language settings. 
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6. Click on the "Next” button. 

System settings 

Define the system settings for Windows: 

7. Activate the option field "Workgroup". 

8. Here you specify the name of the work group ("WORKGROUP” as default). 

 

 

9. Click on the "Next” button. 

 

Note Operation in a domain 

For the operation of the Process Historian in a domain, please refer to the point 
"Integration into a Domain" in the application example "Installation, Operation 
and Maintenance of the Process Historian and the Information Server in the PCS 
7 Environment": https://support.industry.siemens.com/cs/ww/en/view/66579062 

 

Note Change over to a different work group after installation 

If you change the workgroup after the installation, follow the instructions in the 
"Installation, Operation and Maintenance of the Process Historian and the 
Information Server in the PCS 7 Environment" section under "Moving Workgroup 
A to Workgroup B (Workgroup Change)”: 
https://support.industry.siemens.com/cs/ww/en/view/66579062 

 

https://support.industry.siemens.com/cs/ww/en/view/66579062
https://support.industry.siemens.com/cs/ww/en/view/66579062
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Network settings 

Set the network adapter that is to be used for communication. 

In the case of a redundant network, the Fujitsu server has two network cards from 
which you select the first network card: 

10. Under “Adapter”, select the first network card “Fujitsu DynamicxLoM Emules”. 

 

 

11. Click on the "Next” button. 

Service settings 

12. Activate the "SNMP Service" option box. 

13. Deactivate all the other option boxes. 

 

 

14. Click on the "Next” button. 
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Additional settings 

15. Deactivate the option box (if necessary). 

In this application example remote access is not permitted. 

 

16. Click on the "Next” button. 

Application settings 

Do not make any changes to the default settings. 

All the preselected applications are installed 

 

 

17. Click on the "Next” button. An overview of all the selected settings is displayed. 

 

18. Click on the "Start Installation" button. The operating system installation is 
started. 
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Result 

All the pre-settings for the installation of the Windows Server 2012 R2 Standard 
operating system have been concluded. The installation begins and the server 
restarted. 
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3.4.5 Installation 

Observe the following steps when carrying out the installation: 

1. Await the restart of the server. 

The "Unattended Installation running" installation window appears. 

2. When prompted, insert DVD “Operating System – Recovery DVD Windows 
Server 2012 R2 Standard” 

3. Activate option "Install from local drive". 

 

 

4. To trigger the installation, click on the "OK” button. 

 

Note The server is automatically restarted several times. Do not switch the server off 
manually during the installation. 

3.4.6 Finishing the installation 

The following steps must be carried out for the final completion of the operating 
system installation: 

At the end of the installation, a window appears with the prompt to remove all 
removable media from the drives. 

1. Remove the DVD from the drive and click on “OK”. 

The PC is restarted.  
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2. Confirm the license conditions with "I accept". 

 

 

3. In the window "SVIM Messenger: System Restart Required" click on the 
"Restart system" button to restart the server. 
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4. After restarting, deactivate the AIS Connect Service the “AIS Connect Setup” 
window. To do this, click on the “Deactivate AIS Connect” button. 

 

 

5. Click on the "Next” button. 

6. Click on the "Finish" button. The configuration of the AIS Connect Setup is 
concluded. 
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The “SVIM Messenger window: Update Manage Agent: GFUser” appears (if 
necessary, minimize the Server Manager window first). 

If you do not want to receive any new information about the Server Manager 
user settings, click on the "Delete Message" button. 

Otherwise click on the "Remind me again later” button. 

 

Result 

The Operating System of the server has been successfully installed. 
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3.5 Partitioning the hard disks 

3.5.1 Preparing for calibration  

In order to be able to use your Fujitsu server, after the installation of the operating 
system you must allocate the storage sectors and partition the hard disks 
accordingly. 

The hard disk RAID configuration is already initialized.  

Proceed as follows to define the storage volume: 

1. Open Computer Management. Right-click the "Windows Start” button. 

2. Select the "Disk Management" option. The “Initialize Disk” window appears. 

 

 

3. Activate the option boxes of all visible hard disks. 

4. Activate the "GPT (GUID Partition Table)" check box and click on the “OK” 
button. 

 

 

The "Disk Management" window appears with the partitioned hard disks. 
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3.5.2 Performing the partitioning  

Carry out the following steps for all the hard disks on your server. The hard disks 
should have the same names as in the RAID configuration (Section 3.2) of the hard 
disks for easier handling. 

Partitioning the hard disk 

1. Select a non-partitioned hard disk. 

2. Open the editing menu by right-clicking on the non-partitioned sector of the 
hard disk display (represented by black bar) 

3. Click on "New Simple Volume". The Configuration Wizard opens. 
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4. Set the maximum hard disk size and click on the "Next" button. 

 

 

5. Set the new drive letter and click on the “Next” button. 

 

 

6. Select the following settings to format the hard disk: 

• File system: “NTFS” 

• Allocation unit size: “Default” 

• Volume label: Name according to list in Section 3.2 

7. Select the “Perform a quick format” check box. 

If necessary, deactivate the "Enable file and folder compression" checkbox. 
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8. Click on the "Next” button. 

9. Click on the "Finish" button. 

 

Result 

You have successfully partitioned the selected hard disk. Carry out these steps for 
all non-partitioned hard disks. 
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3.5.3 Subsequent modification of the hard disk name 

1. Select the partitioned disk whose name you want to change. 

2. Open the editing menu by right-clicking on the partitioned sector of the hard 
disk display (represented by blue bar) 

3. Click on "Properties". 

 

 

4. You can enter a new name in the settings window. 

The hard disks should have the same names as in the RAID configuration 
(Section 3.2) of the hard disks for easier handling. 

 

 

5. Click on "Apply” to finish and then exit the dialog. 

Result 

You have successfully changed the name of the hard disk. 
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3.5.4 Expansion of the operating system partition 

It may be necessary to adjust the hard disk with the operating system installation 
(usually with the designation letter "C:” for the drive), since during the installation of 
the operating system the hard disk was not completely partitioned / used. 

Perform the following steps to expand and fully partition the operating system disk: 

1. Select the hard drive with the operating system installation 

2. Open the editing menu by right-clicking on the non-partitioned sector of the 
hard disk display (represented by black bar). 

3. Select "Extend Volume…". The Configuration Wizard opens. 

 

 

4. Click on the "Next” button. 

 

 

5. Select the non-partitioned storage area of the hard disk by selecting the hard 
disk in the "Available" sector and adding it to the "Selected" sector by clicking 
on the "Add >" button. 
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6. Use the entire remaining hard disk and click on the “Next” button. Die Overview 
page of the Wizard opens. 

 

 

7. Close the Wizard for the new allocation of the hard disk sector. Click on the 
"Finish" button. 

 

Result 

You have successfully expanded the operating system's hard disk partition. 
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3.5.5 Display of too little unpartitioned storage space 

If the non-partitioned sector of a disk only shows a size of 2048 GB but the actual 
disk sector is larger, then you must convert the disk to a GPT format. 

This allows you to partition the hard drive completely. 

To convert the hard disk to a GPT format, proceed as follows: 

1. Select the hard drive that only displays a sector 2048 GB in size. 

2. Open the editing menu by right-clicking in the non-partitioned sector of the hard 
disk display (represented by black bar) 2048 GB in size. 

 

 

3. Click on "Convert to GPT Disk". This can take several minutes. 

 

Result 

You have successfully converted the hard disk to a GPT format. The non-
partitioned portion of the hard disk now includes the full size of the hard disk. 

 

3.5.6 Aligning the disk names 

To set and ensure the correct Windows hard disk name in accordance with the 
RAID configuration, you can compare the names of the hard disks with the RAID 
configuration. The hard disk numbers are used for orientation. 
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To align the hard disk name, proceed as follows: 

1. Start the "Fujitsu RAID Manager" tool. 

 

 

2. Start the Microsoft “Disk Management” tool. 

3. Compare the names and numbers of the hard disks with each other: 

The numbers of the hard disk are 

• in brackets after the name of the hard disk, e.g. "TagGroup0 (1)". 

• in the MS Disk Management as an identifier in the left sector of the view, 
e.g. "Disk 1". 

• in the hard disk representation of the partitioned sector of the hard disk, 
e.g. "Tag Group0 (D:)". 

 

Result 

In the interests of easier handling, the names of the hard disks are the same and 
correspond to those in Sector 3.2. 
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4 Installing the Process Historian / 
Information Server 
 

The following sections describe the steps required to install the Process Historian 
and the Information Server on the Fujitsu server.  

4.1 Installation of system components required for the 
Process Historian 

For the operation of the Process Historian various system components are 
necessary, which must be installed before the actual installation of the Process 
Historian. 

4.1.1 Installing Message Queuing 

1. Start the Server Manager via "Start > Administrative Tools > Server Manager” 
or via the icon in the task bar. 

 

 

2. Open the context menu of the "Manage" button in the upper right-hand corner 
and select "Add Roles and Features". 
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3. Click on the "Next” button. 

 

4. In the "Installation Type" view, select the "Role-based or feature-based 
installation" option. Click on the "Next” button. 
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5. In the "Server Selection" view, select the server from the server pool. Click on 
the "Next” button. 

 

6. In the "Server Roles" view, leave the default settings. Click on the "Next” 
button. 

 

7. Activate the option "Message Queuing” in the "Features" list. Click on the 
"Next” button. 
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8. Activate in the "Confirmation" view, optionally select the "Restart the 
destination server automatically if required" check box. Click on the "Install” 
button. 

 

9. Wait for the installation to complete and the server to restart. 

Result 

You have successfully installed the “Message Queuing” system component. 
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4.1.2 Installation Microsoft.NET framework version 3.5 

1. Start the Server Manager via "Start > Administrative Tools > Server Manager” 
or via the icon in the task bar. 

 

 

2. Click on "Manage" in the upper right-hand corner and select "Add Roles and 
Features". 

 

 

3. Click on the "Next” button. 

 



4 Installing the Process Historian / Information Server 

 

PH-Installation auf Fujitsu Primergy Server 
Entry ID: 66579062,    V2.0,    07/2017  57 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

7
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

4. In the "Installation Type" view, select the "Role-based or feature-based 
installation" option. Click on the "Next” button. 

 

5. In the "Server Selection" view, select the server from the server pool and 
change the view using the "Next" button. 
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6. In the "Server Roles" view, leave the default settings. Click on the "Next” 
button. 

 

7. Activate the option ".NET Framework 3.5 Features” in the "Features" list. Click 
on the "Next” button. 
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8. If necessary, activate the "Restart the destination server automatically if 
required" check box in the "Confirmation" view. Confirm the message with 
"Yes”. 

 

 

9. Change the source of the installation using the "specify an alternate source 
path" text button and select the installation file. 

You can select, as an installation file, an operating system recovery DVD of 
your server or a locally-saved installation file. 

End the selection of the installation source with the "OK" button. 
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10. Start the installation with “Install." 

11. Wait for the installation to complete and the server to restart. 

Result 

Microsoft.NET Framework 3.5 is installed. 

 



4 Installing the Process Historian / Information Server 

 

PH-Installation auf Fujitsu Primergy Server 
Entry ID: 66579062,    V2.0,    07/2017  61 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

7
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

4.2 Installation of system components required for the 
Information Server 

For the operation of the Process Historian various system components need to be 
installed before the actual installation of the information server itself. 

 

Note If you run only one Process Historian server on the Fujitsu Server, installation of 
the information server is not necessary. 

4.2.1 Installation of the Internet Information Server 

For the installation of the system component "Internet Information Server (IIS)", 
proceed as follows: 

 

1. Start the Server Manager via "Start > Administrative Tools > Server Manager” 
or via the icon in the task bar. 

 

 

2. Click on "Manage" in the upper right-hand corner and select "Add Roles and 
Features". The "Add roles and Features" wizard opens. 

 



4 Installing the Process Historian / Information Server 

 

PH-Installation auf Fujitsu Primergy Server 
Entry ID: 66579062,    V2.0,    07/2017  62 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

7
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

3. Click on the "Next” button. 

 

 

4. In the "Installation Type" view, select the "Role-based or feature-based 
installation" option. Click on the "Next” button. 
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5. In the "Server Selection" view, select the server from the server pool and 
change the view using the "Next" button. 
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6. In the “Server Roles” view, activate the “Web Server (IIS)” option. A dialog box 
opens with a reference to the additional necessary component "IIS Manage-
ment Console". Confirm the additional component with the "Add Features" 
button. 
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7. In the "Features" view, retain the default settings and change the view using 
the "Next" button. 

 

8. In the "Web Server Role (IIS) / Role Services" view, in the "Security" section, 
activate the additional settings "Basic Authentication" and "Windows 
Authentication". 
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9. Activate option "ASP.NET 4.5” in the "Application Development” section. A 
dialog opens with a reference to the additional necessary components "ISAPI 
Filters", "ISAPI Extensions" and ".NET Extensibility 4.5". Confirm the additional 
component with the "Add Features" button. 
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10. If necessary, select "Restart the destination server automatically if required" 
in the "Confirmation" view, and start the installation of the feature using the 
"Install" button. 

 

11. Wait for the installation to complete and the server to restart.  

Result 

You have successfully installed the additional system components for the 
information server. 

4.3 Internet Explorer 11 settings for the Information Server 

Note Internet Explorer 11 is a system requirement for the Information Server and the 
web-based Information Server client.  

 

1. Open MS Internet Explorer 11 as administrator. 

2. Select "Tools > Internet Options". 

3. In the "General" tab, enter the Homepage "http://<Computer name>”. (Setting 
for when the IS web application is not created as a virtual directory). 
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4. Open the “Security” tab. Deactivate the check box "Enable Protected Mode”. 

 
 

5. Click on "Trusted sites" and the "Sites” button. 
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6. Add the website http://<Information Server Computername> to the trusted 
sites. 

To do this, click on the “Add” button. 

Deactivate the option "Require server verification…". 
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7. In the "Security" tab, click on the "Custom level" button. Activate the option 
"Prompt for user name and password" for the Trusted Sites.  

 

Note For the initial commissioning, the "Automatic login with current user name and 
password" setting is required. 

 

 
 

8. Then click on the "OK" button. 

9. Click on the "Yes" button. 

 
 

10. Go to the "Advanced" tab and activate the "Play animations in webpages” 
option. 
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11. Open the "Advanced" tab and deactivate the "Check for publishers' certificate 
revocation” option. 

Click on the “Apply" button and then on "OK". 
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Note In Internet Explorer, go to the Process Historian and deactivate the option 
"Check for publisher's certificate revocation", under "Internet Options > 
Advanced > Security". 

The option delays the opening of the Process Historian Management Console 
and leads to error messages. 
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4.4 Creating a backup copy 

After installation of the operating system, the necessary system components and 
configuration of the operating system, a backup copy of the operating system is 
recommended. 

This way you can return as required to the operating system's original state. 

The creation of an image of the operating system described here is carried out 
using the SIMATIC Image Creator 3.4 tool: 

1. Place the “SIMATIC Image Creator 3.4” CD in the optical drive. 

2. Restart the Server. 

3. Press “F12” while the system is booting in order to access the boot menu. 

4. Select the optical drive as the boot source. 

5. After the tool has started, select the "Backup" option. 

6. Start creating a backup copy. 

 

4.5 Installation of the Process Historian and Information 
Server 

 

NOTICE Specify the name of the server's Windows computer before installation. You can 
change the name of the computer in the Windows System Control under "System”. 

The computer name can no longer be changed after the installation. 

 

Note The installation is to be executed directly in the network environment / 
workgroup, in which the Process Historian is later operated. 

If you use the Process Historian in a domain, join the domain with the Process 
Historian before the installation. 

 

Note For instructions on how to retroactively change the workgroup / domain, see the 
"Installation, Operation and Maintenance of the Process Historian and the 
Information Server in the PCS 7 Environment" section under "Moving Workgroup 
A to Workgroup B (Workgroup Change)" and “Integration in a domain ": 
https://support.industry.siemens.com/cs/ww/en/view/66579062 

 

Note In order to install the Process Historian, it is recommended the same 
administrator-user name and password be used as those employed for the 
installation of the PCS 7 operator station systems. 

 

https://support.industry.siemens.com/cs/ww/en/view/66579062
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Procedure 

1. Insert the PCS 7 V8.2 DVD 1/2 in the drive and start the setup program 
"Setup.exe". 

2. Select the installation language and click "Next". 

 

 

3. Click on the "Next” button. 
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4. Read the PCS 7 readme information and then click on the "Next" button. 

 

 

5. Accept the license conditions and click on the "Next” button. 
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6. Activate the "Install" check box and click on the "Next” button. 

 

 

7. Enter the name and company in the input fields "Name" and "Company". 
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8. Activate the "Package installation" check box and click on the "Next” button. 

 

 

9. Activate the "Process Historian and Information Server" option for the combined 
installation of a Process Historian and Information Server. Then click on the 
“Next” button. 

 

 

Note If you want to install the PH and IS software on different computers, select the 
program packages "Process Historian V8.2" or "Information Server V8.2" 
separately. 
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10. Click on the "Next” button. 

 

 

11. Accept the license conditions and click on the "Next” button. 
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12. Accept the system modifications and click on the "Next” button. 

 

 

13. Start the installation with the "Install" button. 
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The installation is carried out. During the installation, the server is restarted 
repeatedly. 

 

 

14. Click on the “Finish” button to complete the installation and to restart your 
Computer. 

After the last restart, the Database Installation Wizard and the SIMATIC Web 
Configurator will open automatically for the further installation steps. 
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15. Change the service access. Enter an administrator user name and a password 
and confirm your input with the "OK" button. 

 

 

Note For the Data Host Scheduler, it is recommended the same administrator-user 
name and password be used as those employed for the installation of the 
Process Historian. 
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16. Click on the "OK” button. 

 

17. The SIMATIC Web configurator for the information server starts. Confirm the 
default settings with the "OK" button. 
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18. All steps must be completed with the result "Succeeded". After the 
configuration has been completed successfully, terminate the SIMATIC Web 
Configurator with the "Exit" button. 

 

 

19. Activate the configuration by restarting the server. To do this actuate the “OK” 
button. 

 

 

20. Perform the Database Installation Wizard as described in section 4.7. 

4.6 Notes on Process Historian Database Segmentation 

Note With regard to the segmentation, please also observe the Process Historian 
product documentation.  

 

The Process Historian features database segments, runtime segments and archive 
segments.  

Database segments 

A database segment in the Process Historian is the quantity of all the data in 
a defined time range. If you choose a weekly segmentation, then a database 
segment will contain all the data recorded in one week.  

The preset value for the segmentation is: 

• Time range of a segment = 1 week 

• Number of prepared segments = 1 
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• Total number of Runtime segments = 5 

This is a meaningful preset value adequate for most applications. 

Runtime segments 

Runtime segments are uncompressed and therefore take up more space on the 
hard disk. 

They are characterized by the fact that they are always in the "online" state and 
the PH can write the data into runtime segments. 

The runtime segments are visible in the “Segmentation” menu of the PH 
Management Console (MMC). 

 

 

The Process Historian creates segments continuously for a defined time range. 
To ensure that all data can be saved regardless of the time stamp, there is an 
upper and a lower "catch-all" segment. 

The specific segments collect all incoming data that lie outside the current runtime 
segments. These segments are called "catch-all-upper" (CAU) and "catch-all-
lower" (CAL). 

The CAL and CAU segments are permanently available and cannot be erased, 
removed or set to offline. 

 

Number of uncompressed segments = "Total number of runtime  
segments" + CAL segment + CAU segment = "Total number of runtime 
segments" +2. 

 

In the above example: 

Number of uncompressed database segments = 4+2 = 6. 

This means that 6 segments will always remain uncompressed. 

Archive segments 

Archive segments can be found in the PH MMC menu "Backup/Restore". An 
archive segment can be in two states: 

• Online 

• Offline 
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If an archive segment is in the online state, the PH can have read access to the 
data. 

If an archive segment is offline, it means that the data have been successfully 
backed up in a backup file and the data have been deleted from the database. 

The PH can only access the data again when the database segment is in the 
"Online" state.  

In this sense 

• "Set offline" means to delete data of a segment from the database. 

• "Restore" means to restore data of a database segment 
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4.7 Executing the Database Installation Wizard 

After the installation of the Process Historian and the Information Server, run the 
"Process Historian Database Installation" wizard once. This is done automatically 
after the installation is restarted. 

If the wizard does not start automatically, you can activate it by restarting the 
Process Historian Management Console. The Process Historian Management 
Console checks if a Historian database is present. If there is no Historian 
Database, the Database Installation Wizard is started. 

Alternatively, you can start the Wizard directly in the following path: 
"C:\Program Files\SIEMENS\ProcessHistorian\bin\DatabaseInstallationWizard.exe” 

 

NOTICE Note that a retroactive modification of the hard disk configurations of a 
database is only possible with considerable effort or possible data loss. 

 

Analysis of database hard disks 

To configure the database, perform the following steps: 

1. Start the “Process Historian Database Installation” wizard. 

2. Activate all the hard disks using the option boxes that are used for data 
archiving. 
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3. Deactivate the option box "System (C:)" (Hard drive with operating system (C:)) 
and "IS DB (H:)" (Hard drive: for the Information Server). 

 

4. Start the data analysis by clicking on the "Start analysis" button. 
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5. After the analysis has finished, click on “Next”. 

 

 

6. Activate the "Installation as a stand-alone system" check box and click on the 
"Next” button. 
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Result 

A summary of your server's performance characteristics appears in an analysis 
overview. Leave this view open for further database hard disk settings.  

 

Adaptation of the database hard disks 

Determine the hard disks for archiving the data according to the RAID configuration 
(Section 3.2) in the analysis view of the "Process Historian Database Installation" 
wizard. 

 

Note For a better I/O performance of the Process Historian, the corresponding 
"Runtime" and "Runtime Compressed" sectors of a data group should be stored 
on different hard disks. 

 

The target locations of the data according to the RAID allocation in Section 3.2: 

Data Path 

Runtime Data Group 0, Compressed Data Group 3 D:\Historian\DB 

Runtime Data Group 1, Compressed Data Group 0 E:\Historian\DB 

Runtime Data Group 2, Compressed Data Group 1 F:\Historian\DB 

Runtime Data Group 3, Compressed Data Group 2 G:\Historian\DB 

Configuration data, General database data  I:\Historian\DB 

Transaction logfile J:\Historian\TA 

SIMATIC BATCH data K:\Historian\DB 

Alarms and Operator Messages L:\Historian\DB 
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Specify the destination of the data as follows: 

1. Open the settings menu of the respective data group via the "Change..." text 
button. 

 

2. In the settings window, make the following configurations: 

• Set the path for the transaction logfile according to the above table in the “Path 
for the transaction log file” text box. 

Confirm the prompt to create a new folder with the "OK" button.  

 

• Activate the "Use server as Simatic Batch repository" option field. 

When the option field is activated, the data group quantity is reduced by one. 

• Set the hard disks according to the above list for the different types of data. 

Select data types via the "Repository for" drop-down list: 
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Values in the "Repository for” drop-
down list 

Data 

“General” Configuration data, General database data 

“Process values” Runtime Data Group 0 – 3, 

Runtime Compressed Data Group 0 – 3 

"Messages” Alarms and Operator Messages 

"Batches”  SIMATIC BATCH data 

 

 

3. Exit the settings window with "Accept". The "Summary" values are displayed. 
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4. Open the settings menu "Estimated data load” by clicking on the "Change..." 
button. 

 

5. Adjust the expected data volumes for process values and messages and 
confirm with "Accept". 

 

Note If you have only one hard disk for storing the process values, you cannot actuate 
the "Data group counter" setting. 
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6. No changes to the segmentation settings are necessary. Use the segmentation 
default setting. 
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7. Define the repository for the messages, process values and batch data with 
the setting "All Runtime messages are located in the folder" by clicking on the 
"Change..." button. 

 

 

8. To change the repository of messages, process values, and batch data, use 
the drop-down list. 
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9. Define the repository for the messages. 

 

 

10. Define the repository for the process values. 

 

 

11. Define the repository for the batch data. 
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12. Verify that all settings are correct and create the database by clicking on the 
“Finish” button. 
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Result 

The database is created. This can take several minutes. 

When finished, restart the Process Historian.  

 

 

 

Note After creating the database, you ought to check the file system and the 
repository to see if this has been done according to your settings. 

Use of the classic database Installation Wizard 

Note The classic database Installation Wizard should only be used by experienced 
system administrators and then, only in exceptional cases. 

 

Since Process Historian 2014 SP2, the Database Installation Wizard examines the 
server’s hardware and makes suggestions for data distribution. 

These suggestions depend on the number of hard disks, free hard disk space, and 
other configuration settings. 

In exceptional cases, a manual definition of the data distribution may be necessary, 
e.g. if more data groups are required than hard disks are present. 
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Procedure 

1. Start the Run box from the Windows Start menu 

 

 

2. Start the classic mode of the Database Installation Wizard from the Run box. 
To do this, enter the following command: 

“C:\Program  
Files\SIEMENS\ProcessHistorian\bin\DatabaseInstallationWizard.exe/classic” 

3. Confirm your entry with "OK". 
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4. After starting the wizard, confirm with the "Next” button. 

 

 

5. Click on the "Next” button. 
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6. Specify the usable memory for the Process Historian. 

 

 

Note For the SQL server, the amount of random access memory to be used can also 
be set in the SQL Management Console. 

 

7. Activate the "Installation on a stand-alone or the master (principal) server" 
check box and click on the "Next” button. 
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8. Activate the "Create an initial database" check box and click on the "Next” 
button. 

 

9. Activate the "Advanced" check box and click on the "Next” button. 
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10. Define the segmentation settings and click on the "Next” button. 

 

11. Specify the amount of data groups, process values and messages, and click 
on the "Next" button. 
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12. Determine the repository for process values, messages and batch data as 
described in Section 4.6 

 

 

13. Create the database by clicking on the “Next” button. 

 

Result 

The database is created. This can take several minutes. 

When finished, restart the Process Historian. 

 

Note After database has been created, you ought to check the file system and the 
repository to see if this has been done according to your settings. 

4.8 Configuring the PH redundancy service 

For information on redundant Process Historian servers and the use of a Witness 
Service component, please refer to the manual "Process Historian: Administration". 

Even if you do not use a redundant Process Historian, the PH Redundancy Service 
is installed. 

If the Service Configuration Wizard appears after the PH restart, perform the 
following steps: 

1. When the "Welcome" screen appears, click on the "Next" button. 



4 Installing the Process Historian / Information Server 

 

PH-Installation auf Fujitsu Primergy Server 
Entry ID: 66579062,    V2.0,    07/2017  105 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

7
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
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2. Enter the user name and password for the SIMATIC Process Historian 
Redundancy Service. It is recommended to use the same user name and 
password as for the installation of the PH and IS and the OS systems if 
possible. Click on the "Next” button. 

 

 

3.  Click on the "Finish" button. 
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4. Click on the "Close" button to close the configuration window. 

 

 

Result 

The "PH Redundancy Service" service has been configured. 

4.9 Installation of the Information Server within Internet 
Explorer 

Note: 

From information server version 2014 SP2 onwards, you have the option to run the 
information server database on a dedicated drive. 

You can perform this setting after successful installation of the Information Server 
and the SIMATIC Web Configurator: 

 

1. Open Internet Explorer 11 with Administrator rights. 

2. Enter the URL: http://localhost 

3. For the combined operation of Process Historian and Information Server, 
select the SQL Server instance "HISTORIAN". 

 

 

Note For an information server installation without a Process Historian installation, 
select the server instance "INFSERVER". 

 

4. Select option “Manually specify location of database”. 

5. Specify the hard disk and the storage location of the information server 
database. 

http://localhost/
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1

2

 

6. Start the installation with the “Install” button. 
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7. Wait until the installation is complete. Conclude installation with the “Continue” 
button. 

 

Result 

Setup has completed successfully. 

To use the information server, you must connect it to the Process Historian as a 
data source: 

1. Open the “Administration” menu in the information server. 

2. Activate the option "Process Historian". 

3. Enter the server name of your Process Historian. 

4. After entering the server name, select the project. To do this, click on the 
“Select projects” button. 
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5. Highlight your project and add it to the project list. To do this, click on the “Add” 
button. 

 

Result 

The Information Server is now connected with the Process Historian. 
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Note: 

To connect a Process Historian project to the Information Server, the Process 
Historian must have received data from an OS system. Otherwise, the project list is 
empty. 
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4.10 Installing an Information Server client 

4.10.1 Web Information Server Client installation 

When using an Internet Explorer-based IS client, no further installations are 
required. Internet Explorer 11 is a system requirement and the necessary IE 
settings have to be made. 

4.10.2 Installing an MS Office IS client 

Requirements 

The following software must already have been installed: 

• A suitable version of Microsoft Office containing the applications Word, 
PowerPoint and/or Excel must be installed. 

• Microsoft.NET Framework 4.0 

• VSTO (Visual Studio Tools for Office) 

 

The IS 2014 supports the following Office versions: 

Table 4-1 

Product  Remarks 

Microsoft Office 2007 SP3 32-bit 

Microsoft Office 2010 SP1 32-bit 

Microsoft Office 2013 32-bit 

Installation with the help of the PCS 7 DVD setup 

1. Insert the PCS 7 V8.2 DVD 1/2. 

2. Start the "Setup.exe” setup program. 

3. Select the setup language and click on the "Next” button. 
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4. Click on the "Next” button. 

 

 

5. Read the PCS 7 readme information and then click on the "Next" button. 
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6. Accept the license conditions and click on the "Next” button. 

 

 

7. Select "Install" and click on the "Next" button. 
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8. Enter the name and company in the input fields "Name" and "Company” and 
click on the “Next” button. 

 

 

9. Activate the "User-defined installation" check box and click on the "Next” 
button. 
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10. Activate the "Information Server – MS Office Add-In 2014" check box and click 
on the "Next” button. 

 

 

11. Accept the system modifications and click on the "Next” button. 
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12. Start the installation by clicking on the “Install” button. 

 

 

The IS Office Add In and VSTO Runtime are installed. 
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13. Insert - if necessary - the PCS 7 V8.2 DVD 2/2 and click on the "OK" button. 

14. Click on the "Finish" button. 

 

 

The Information Server menu is now available e.g. in MS Excel. 
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Installing using the IS 

• Installation of MS Office 

• VSTO installation from the PCS 7 DVD 

Two installation versions are available: 

• vstor40_x86.exe -> for 32-bit operating systems 

• vstor40_x64.exe -> for 64-bit operating systems 

 

You can find the setup program in the folder  
"<DVD 2/2>:\27_InformationServer__V8.2\VSTOR" on the PCS 7 DVD 2/2. 

 

 

If necessary, install Microsoft.NET Framework 4.0. 
You will find Microsoft.NET Framework 4.0 on the PCS 7 DVD 1/2 under the 
path: "08_DotNetFramework\ NDP451-KB2858728-x86-x64-AllOS-ENU.exe". 
See also section 2.3.2: Requirements for the Office IS client. 

Start installation by double-clicking on the file and follow the installation 
instructions. 

Installation of the MS Office Add-in using the Information Server 

1. Open the "Download" menu in the IS. Click on the "Download" link. 
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2. Click on the "Run" button and follow the installation instructions. 

 

 

Testing the Office add-in 

1. Open Microsoft Excel. 

2. Click on the "Information Server > Server" menu. 

 

 

3. Enter the computer name of the Information Server, and then click on "OK". 

 

 

4. Select the menu sequence “Tags > Insert tag". 

 

 

  



4 Installing the Process Historian / Information Server 

 

PH-Installation auf Fujitsu Primergy Server 
Entry ID: 66579062,    V2.0,    07/2017  121 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

7
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

5. Select your project and open the "Tag Browsing" dialog. 

 

 

6. Select a tag and click on the "OK" button. 
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7. Select "Header", "Time stamp" and "Quality code" and click on the "Insert" 
button. 
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8. Click on the "Close" button 

 

 

9. Change to the “Run" menu. 
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Result 

The pH values are read into the Excel cells. 
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5 Installation of the Operator Station 
 

Note The requirements for installing the operating system on an OS server or OS 
single station must be met. 

 

NOTICE The computer SID is a unique security identifier. The Process Historian 
identifies the OS systems from their computer SID. 
Computers that have the same computer SID and swap data onto the PH, 
cannot be clearly identified by the PH. This may cause malfunctions on the 
PH. 

If computers are cloned, the computer SID is not adjusted automatically. 

In the PCS 7 environment, unique computer SIDs are a requirement for 
error-free functionality. 

Installation requirements 

Check whether the installation requirements described in the Manual "PC 
Configuration and Authorization" have been met.  

In addition, the current information of the PCS 7 readme file must be observed. 

The Installation Notes for the "PHReady" component are also to be observed. 

You can find these in the product DVD 1, in the path "<DVD 
drive>:\27b_PH+IS_Install_and_Release-
Notes\German\InstallNotesPRHIdeDE.pdf", in the section "Installing Process 
Historian Ready on a PCS 7 Operator Station". 

Introduction 

PCS 7 OS server and OS single stations for PCS 7 V8.0 are used for the long-term 
storage of data using the Process Historian. The "PH-Ready" component must be 
additionally installed for communication between the OS and the PH. 

Here, you have two options: 

• Installation of an OS server for the Process Historian 

• Retroactive installation of the "ProcessHistorian Ready" component on an 
existing OS server / single station 

After completing the installation of the PH-Ready component on the OS, the 
"CCCAPHServer" service is installed to aid communication with the PH. 
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5.1 Installation procedure for the "OS Server for Process 
Historian" 

1. Insert the PCS 7 DVD 1/2 in your DVD drive. 

The PCS 7 setup starts automatically. 
You can also start the installation directly from the PCS 7 DVD 1/2 by double-
clicking on the “Setup” application. The setup file is located in the root directory 
of the DVD. 

The name of the setup program is "PCS 7 Frame Setup". It allows all PCS 7 
components to be selected. 

2. Select the desired setup language. Click on the "Next” button. 

 

 

3. Click on the "Next” button. 

4. Read the product notes and click on the "Next” button. 

5. Accept the setup conditions. Click on the "Next” button. 
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6. Select the "Install" setup type if you want to install the OS station from scratch. 
Click on the "Next” button. 

7. Enter the user name and company name. Click on the "Next” button. 

8. Select “Package installation”. Click on the "Next” button. 

9. Select the "OS Server for Process Historian” program package and click on the 
“Next” button. 

 
 

10. Agree to the license agreement and then click on the "Next" button 

 

 

11. Confirm the changes to the system settings and click on the "Next” button. 

12. Click on the "Install” button. 

 

Note During installation, you will need to change the PCS 7 DVD and the computer 
will need to be restarted. 



5 Installation of the Operator Station 

 

PH-Installation auf Fujitsu Primergy Server 
Entry ID: 66579062,    V2.0,    07/2017  128 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

7
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

 

The OS server software and the "ProcessHistorian Ready" software component 
have been installed. 
The installed PCS 7 software is displayed in a side window. 
 

13. Restart your computer. 

14. After the computer restarts, the "Service Configuration Wizard" for the 
"CCCAPHServer” starts automatically. 

Click on the "Next” button. 
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15. Use the same user name and password here as the ones used for the PH 
installation and then click on the "Next" button. 

 
 

16. Click on the "Finish" button. 

 

 

17. Click on the "Close" button 

Result 

The "CCCAPHServer" service has been installed in the OS including the necessary 
licenses. 
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Note If the Service Configuration Wizard does not start automatically, you can start the 
wizard manually at any time from "Start > All Programs > SIMATIC> PH-Ready> 
PH-Ready Configuration". 
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5.2 Installation procedure for the "OS Single Station for 
Process Historian" 

The installation procedure corresponds to the "OS Server for Process Historian" 
installation. In the "Program Packages" dialog box, select the option "OS single 
station for Process Historian". 
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5.3 Installing the "ProcessHistorian Ready" component 

The installation procedure corresponds to the "OS Server for Process Historian" 
installation. However, the installation must made as user-defined. 

 

 

Activate the "ProcessHistorian Ready Component" check box. 
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6 Software update installation 
Process Historian / Information Server is permanently further developed and 
optimized. 

We recommend that you install the latest update for PH, PH-Ready and IS 
available at the time of installation. 

Typically, the update is installed after PH / IS 2014 SP2 is installed. 

You will find the software updates in SIEMENS Online Support: 

https://support.industry.siemens.com/cs/document/20780602?dti=-1&lc=de-WW 

Search for "Process Historian 2014 SP2 Update" or "Information Server 2014 SP2 
Update". 

 

NOTICE Always read and observe the readme file and the installation notes of the 
corresponding software updates. You will find the information in the Online 
Support. 

 

https://support.industry.siemens.com/cs/document/20780602?dti=-1&lc=de-WW
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7 PH engineering in a PCS 7 project 
As an example for the use of the Process Historian, we use the "getting-started" 
project "color_gs" for PCS 7. 

1. Call up the project from the Engineering System. 

2. Adjust the hardware configuration of the "color_gs" project to your local 
situation in accordance with the usual PCS 7 process. 

3. Insert a new SIMATIC PC station. 

 

 

4. Open the object properties of the new PC station and enter the same computer 
name as for the PH device. 
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5. Open the PH hardware configuration and insert a "Process Historian" object. 

 

 

6. Save the PH hardware configuration.  

7. Open the object properties of the OS server and activate the check box 
"Transfer to external archive server". 

 

 

Note If you are using an ES / OS single station, you must specify the PH for the OS 
Single Station using the "Assign archive server" button. 
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8. Open the “Process Object View” and select the “Long-term archiving” property 
for all available archive tags. 

 

 

Note All long-term relevant OS archive tags of an OS station are stored in the PH, 
provided that a PH has been configured. 

 

9. Compile and download the OS. 

Result 

The OS is now configured in such way that all long-term relevant archive tags are 
stored in the PH system. 

PH configuration for several multiprojects 

If you want to save the long-term relevant data from several PCS 7 multiprojects 
(MP) on one PH system, you need to configure this PH in every MP. In each MP, 
the computer name of the PC station must always match to the name of the PH 
computer.  

In each OS from which archive data is stored in the PH, the name of the PH 
computer is written to the "ProcessHistorian.cfg" file. The "ProcessHistorian.cfg" 
file is located in the root directory of the OS project. 
 

Note The folder "C:\Users\Public\Public Documents\Siemens\WinCC" contains a 
further file called "ProcessHistorian.cfg". This file is just a template. Do not write 
the name of PH computer in this file. 
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8 Commissioning 
This section describes the commissioning of the Process Historian (PH) and 
Information Server (IS). It is not necessary to download the Process Historian and 
Information Server from the Engineering Station. 

8.1 Sequence for initial commissioning 

When commissioning, start the PH before the OS servers. The PH must also be in 
the "Active" operating state before the OS systems are started. If the PH is started 
after the OS server, it may be the case that the OS system does not build up the 
necessary message queues correctly. 

8.2 Redundant OS server 

When using redundant OS systems, the OS servers may not be started 
simultaneously during the first commissioning. Start the master OS server first and 
then, a few minutes later, the standby OS server. 

If you start the OS systems simultaneously, the pH might fail to recognize the 
systems as a redundant OS system. 

When using redundant OS servers, only the master OS server sends data to the 
PH. The standby OS server also builds message queues for the PH, but it sends 
no data. 

After initial commissioning, the master OS server sends data to the PH when the 
Store And Forward Buffer (S & F Buffer) is matched. After first commissioning, the 
Master also sends data if the store and forward buffer is not synchronized.  

If the master of a redundant WinCC server sends no data after the initial 
commissioning, you must the store and forward buffer synchronization.  

 

1. Determine the current OS master. The redundancy status can be checked 
using, for example, the WinCC tag management. 

 

 

  



8 Commissioning 

 

PH-Installation auf Fujitsu Primergy Server 
Entry ID: 66579062,    V2.0,    07/2017  138 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

7
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

2. Open the PHSFSettings file on the Master OS server. 

The file is saved under "C:\ProgramData\Siemens\SFCache". 

 

 

3. Determine the synchronization state. 

 

 

If "WinCCSyncState = Error" occurs, the master does not send any data to the PH 
after initial commissioning.  
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8.3 Process Historian 

Requirements 

• The Process Historian must be installed. 

• The "HistorianStorage" database was created with the installation wizard. 

• The PH database segmentation has been predefined. 

• A server license for the Process Historian must be present 

If the license does not exist, the PH does not switch to the "Active" state after 
the computer starts. 

• The necessary PH services are running: 

• SIMATIC Process Historian Service 

• Process Historian Maintenance Service 

• Process Historian Discovery Service 

• The PH is activated. 

• PH-Ready (CCCAPHServer Service) is installed on the OS server and has 
started. 

• The pH has been configured in the PCS 7 project 

• The OS project has been loaded on the target OS server. 

Procedure 

1. Open the management console of the Process Historian in the PH/IS system. 
In the list, select select "Process Historian Management”. 

 

 

There is no connection to a physical data source and there are no tags or alarm 
messages saved. Every OS system with data stored on it serves as a source. The 
PH receives the configuration data from each configured OS system.  
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When using a redundant OS, the two physical devices act as source system and 
the archive configuration data are transmitted from both devices. In a redundant 
OS, runtime data is only sent from the current Master OS to the PH. 

 

2. Open the WinCC Explorer on the OS server and start the loaded OS project. 

The OS server sends the configuration data to the PH. You can see that a 
source device (OS server) is connected to the PH. 
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3. Start the OS runtime.  
After starting the OS runtime, long-term relevant archive tags and OS 
messages are stored in the PH. 
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8.4 Information server 

Requirements 

• The Process Historian must be running. 

• The Information Server must be installed. 

• A website has been created with the configuration manager. 

• Internet Explorer has been set up correspondingly. 

• The following licenses must be available: 

• License for the Information Server 

• Client access license for the Information Server 

Procedure 

1. Open Internet Explorer. Enter http://<Computer name> in order to establish a 
connection. 

 

 

2. Enter the same username and the same password that were set during the 
installation process. 
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3. Click on the menu item "Administration". 

4. Click on the menu item "Configuration". 

5. Click on the menu item "Reporting". 

6. Click on the "Project" menu. 

7. Enter the PH computer name in the "Server Name or IP Address" field. 

Select the "Process Historian” radio button. 

Click on the "Select projects" button. 
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8. Select your project and click on the "Add" button. 

 

 

You have connected a PH-data source to the IS. 

 

 

9. Switch to the "Reporting" dialog box.  
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10. To access the data stored in PH, use a standard report template. 

In the "tags" folder, select the "Table" template. 

 

 

11. Click on the "Create Report/subscription" button 
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12. Specify a project, a start and end time, and then click on the "Add" button to 
select a tag. 
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13. Click on the "+" button to select a tag you want to see in the report. 
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14. Click on the "Save" button. 

 

 

15. Click on the "Show preview” button. 
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Result 

The report is displayed as a preview. 
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9 Troubleshooting / System checking 
In this section, different scenarios are used to describe the possibilities of checking 
and mode of procedure in different situations. This requires advanced computer 
skills. 

9.1 Manually call up the installation wizard for the PH 
database 

If errors occurred when creating the "HistorianStorage" database, the database 
installation wizard can also be started manually. 

If a HistorianStorage database is already attached to the SQL Server, it will be 
deleted the next time the installation wizard will run. All data will be lost! 

 

Note If an existing HistorianStorage database is not be deleted when re-running the 
installation wizard, the existing HistorianStorage must be detached from SQL 
Server beforehand. The new HistorianStorage database must be created in 
another directory.  

 

After installing the PH, the database installation wizard can be found in the 
following directory: 

"C:\Program Files\SIEMENS\ProcessHistorian\bin\DatabaseInstallationWizard.exe” 
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9.2 Invoking the Configuration Wizard manually for the IS 

NOTICE If the IS configuration assistant has already run successfully, you may run 
this a second time from PCS 7 V8.1 SP1 = IS 2014 SP1 only.  

You may, for example, need to re-run the configuration wizard to switch the 
website to a "virtual directory".  

 

The Configuration Wizard serves to create the website for the Information Server. 
If the Configuration Wizard still hasn't been executed successfully after installing 
the IS, the wizard can be started retroactively. 

Double-click on the "ConfigurationManager.exe" file. The website is created anew. 

The Configuration Manager is available in the following directory:  
"C:\Program Files (X86)\SIEMENS\InformationServer\ConfigurationManager". 
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1. Start the Configuration Wizard by double clicking the file  
"C:\Program Files (x86)\SIEMENS\InformationServer\ConfigurationManager\ 
ConfigurationManager.exe". 

The program starts creating the IS website without further prompts. 

 

 

2. Answer "No" to the question whether you want to restart the system. 

 

 

3. Before you restart the PH/IS system, you must shut down the PH from the PH 
Management Console ("Shutdown"). 

4. Then restart the system. 

 

Note If you re-run the configuration wizard, any manual changes to settings will be 
reset to their default setting. 
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9.3 Checking the OS installation for PH Ready 

Scenario 

The operator station is configured for storing long-term relevant archive tags on the 
PH-computer. The OS has been loaded and is in runtime mode. The PH is also in 
runtime mode, but no tags and alarm messages are saved. 

Recommended system tests and measures 

1. Use the PH computer name to ping the PH-computer from the OS. The reply to 
the ping should be received within a few ms. If the ping does not work, there is 
a network problem.  

2. Use the OS computer name to ping the OS computer from the PH. The reply to 
the ping should be received within a few ms. If the ping does not work, there is 
a network problem. 

3. Use the PH computer name to ping the PH computer from the PH itself. The 
reply to the ping should be received within a few ms. If the ping does not work, 
there is a network problem. 

4. If you have network problems, check if the "hosts" file is being used and if all 
registered IP addresses and their computer names are correct. You can find 
the "hosts" file in the directory "C:\Windows\System32\drivers\etc". 

5. Check whether the "CCCAPHServer" service has started on the OS. 
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The "CCCAPHServer" service must be running / started using the same account 
name and password as the Process Historian Computer. 

 

 

The "SIMATIC Process Historian" service on the PH is started via the local system 
account. 
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6. Check the queues for outgoing messages on the OS. The queues must be 
created and shown as "Connected". 

 

 

7. Problems in the connection of queues can be identified from the "Waiting to 
connect" status, by going to "Server Manager > Features > Message Queues”. 

 

  

 

 



9 Troubleshooting / System checking 

 

PH-Installation auf Fujitsu Primergy Server 
Entry ID: 66579062,    V2.0,    07/2017  156 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

7
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Possible causes 

1. Unauthenticated RPC calls are blocked on the PH and must be first enabled. 

• This setting can be done via the Server Manager, in "Server Manager > 
Features > Message Queues > Properties > Server Security". 

• Deactivate the "Disable unauthenticated RPC calls" checkbox. 

 

 

2. If the message queues on the OS system are in the "Waiting to connect" state, 
restart the Message Queuing service on the PH. 
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3. The state of the Message Queues in the Server Manager is not updated 
cyclically. Click the "Refresh" button to display status changes. 

 

 

4. Check whether the "ProcessHistorian.cfg" file was created and if the PH 
computer name is correct. 

5. The engineering system creates a "ProcessHistorian.cfg" file for each OS 
project, whose data is stored on the PH. This file is present in each OS and 
includes the PH computer name and the names of the MS message queues 
used. The "ProcessHistorian.cfg" file is located in the root directory of the OS 
project. 

If the "ProcessHistorian.cfg" file has not been created, check the  
PCS 7 project in terms of PH configuration and compile the OS. 

 

Note If the OS single station is running on the ES, you have to use the "Assign 
Archive Server" button, located in the object properties of the OS. 
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9.4 Checking the PH installation 

Scenario: 

The operator station is configured for storing long-term relevant archive tags on the 
PH-computer. The OS has been loaded and is in runtime mode. The PH-Ready 
configuration on the OS has been checked but no tags and alarm messages are 
stored on the PH. 

Recommended system tests and measures 

1. Use the OS computer name to ping the OS computer from the PH and vice 
versa. The reply to the ping should be received within a few ms. If the ping 
does not work, there is a network problem.  

2. Check whether the status of the PH is set to "Active". If the PH-Status is not 
"Active", set it to "Active" from the PH management console. 

Select "Start" and then click on "Go". 
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3. Use the Automation License Manager and the PH MMC to check whether all 
necessary licenses are available. The PH does not function without a valid 
license. 

 

 

4. Check if PH errors are shown in the PH MMC "Diagnosis" menu and remedy 
any problems. 

5. Check whether queues have been generated on the PH. 

To do this, open Server Manager and choose "Features > Message Queuing > 
Private Queues". 
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Example 

If queues have been generated on the PH-computer for tags and messages, but 
the data cannot be written to the PH database, the number of queued messages 
increases. For tags such as the "phtlgrtdata" queue. 

In this case, the PH must be activated. 

 

 

6. Check whether the "HistorianStorage" database has been created. 

Open the SQL Server Management Studio via "Start > All Programs > 
Microsoft SQL Server 2008 R2 > SQL Server Management Studio". 
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7. Establish a connection to the SQL Server instance  
"<computer name>\ HISTORIAN". 

 

 

8. Check whether the "HistorianStorage" database exists. 

If this database does not exist, start the "Database Installation Wizard". 
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9. Check whether the PH has already received configuration data from the OS. 
Navigate via the SQL Server MMS to the view "HistorianStorage> Views> 
IS.VtagBrowsing" and select the shortcut menu "Select Top 1000 Rows". 

 

 

If you then receive data results, the PH has received the configuration data from 
the OS. 

If you get no results after this SQL query, yet the PH seems to be fine, check the 
OS. Restart the PH. If possible, restart the OS, and check again to see if the PH 
now receives configuration data from the OS. 

 

10. If it is a redundant OS system, check whether the store and forward buffer on 
the OS is synchronized. 
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9.5 Checking the MS Reporting Services 

Scenario 

PH and IS are installed. The OS server stores data on the PH computer. When you 
connect the IE IS client to the IS, no logs can be created. 
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Recommended system tests and measures 

1. Check whether the IS Report Server has started. If the "Stop" button can be 
operated, then the report server has started. 

 

 

2. Check the Web Service URL settings. 
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3. Check the settings in the Report Server Database. 

 

 

4. Check the Report Manager URL. 
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9.6 Log files 

The following log files are available for the diagnosis of PH, IS and PH-Ready. 
Some of these log files are located in the "ProgramData" folder. This directory path 
must be displayed in Windows Explorer. 

Process Historian 

C:\ProgramData\Siemens\Logs\ProcessHistorianUI.diagnostic.log 

C:\ProgramData\Siemens\Logs\Processhistorian.diagnostic.log 

C:\ProgramData\Siemens\Logs\MaintenanceServer.diagnostic.log 

C:\ProgramData\Siemens\Logs\DiscoveryService.diagnostic.log 

Information server 

The IS log files are located on the IS, in the directory path: 

C:\ProgramData\Siemens\Automation\Logfiles 

C:\Program Files (x86)\SIEMENS\InformationServer\log 

PH-Ready on the OS 

The log files for the PH-Ready log are on the OS, in the directory path: 

C:\ProgramData\Siemens\Logs\ProcessHistorian 

PH-SQL Server 

C:\Programme\Microsoft SQL Server\MSSQL10_50.HISTORIAN\MSSQL\Log  

PH-SQL Server 

C:\Programme\Microsoft SQL Server\MSSQL10_50.HISTORIAN\MSSQL\Log 
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9.7  Starting the PHControl Message Queue 

In rare cases it can occur that after starting the OS runtime or restarting the 
Process Historian, the PHControl Message Queue remains in a "Waiting to 
connect" state. 

In this case, the Message Queuing service of the Process Historian has to be 
restarted. 

 

Procedure 

1. Start the Server Manager. 

2. Navigate to the "Configuration\Services\Message Queuing" service. 

3. Open the context menu for the "Message Queuing" service and run the 
"Restart" function. 
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Result 

The PHControl Message Queue connects successfully after restarting. 

 

9.8 IS client message "You are using outdated browser. 
Please update your browser" 

 

 

This message is caused by wrong “Compatibility view settings”. 
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Remove the "Display intranet sites in Compatibility View" setting. 
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9.9 Microsoft.NET Framework 4.0 

Scenario 

After establishing the connection with an Internet Explorer IS client, the website of 
the Information Server does not work. 

Possible cause 

Unregistered Microsoft.NET Framework 4.0. 

9.9.1 Checking the registration of Microsoft.NET Framework 4.0 

1. Open the Server Manager on the IS. 

Select "Roles > Web Service (IIS) >Internet Information Services > ISAPI and 
CGI Restrictions". 

 



9 Troubleshooting / System checking 

 

PH-Installation auf Fujitsu Primergy Server 
Entry ID: 66579062,    V2.0,    07/2017  172 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

7
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

2. Select the "Open Feature" menu item. 

 

 

3. Check whether Microsoft.NET Framework 4.0 is registered. 

 

 

9.9.2 Registering Microsoft.NET Framework manually 

After the installation of Microsoft.NET Framework, this is indicated in the following 
installation directory: 

<WindowsDir\Microsoft.NET\Framework64\<version number>\. 

Example 
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For manual registration, you must call the DOS command prompt and open the 
folder "DotNetFramework". 

 

 

Type in the command "aspnet_regiis.exe -i" and press the Enter key. 

 

 

The registration completes within a few seconds. 

 

 

9.10 Checking the Internet settings of the IS server 

Scenario 

PH and IS are installed. The OS server stores data on the PH computer. When you 
connect the IE IS client to the IS, no logs can be created. 
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Recommended system tests and measures 

1. Check whether the website was created for the Information Server. To do this, 
open the Server Manager and select "Roles > Web Server (IIS) > Internet 
Information Service (IIS) Manager" to see if an Information Server website 
exists.  

2. If no website exists, start the "IS Configuration Wizard" manually to generate 
the website. 
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3. Check the IIS settings. 

To do this, open the Server Manager, select "Roles > Web Server (IIS)”. Open 
the "Web Server (IIS)" shortcut menu (right-click) and select "Add Role 
Services". 

 

 

4. Compare the settings with the following screenshots. 
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5. The IS Configuration Wizard creates two websites. 

Check which website is active and whether the correct URL is being used. 
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10 Appendix 

10.1 Service and Support  

Industry Online Support 

Do you have any questions or need assistance?  

Siemens Industry Online Support offers round the clock access to our entire 
service and support know-how and portfolio.  

The Industry Online Support is the central address for information about our 
products, solutions and services.  

Product information, manuals, downloads, FAQs, and application examples – 
all the information you need is accessible with just a few mouse clicks at:  
https://support.industry.siemens.com/ . 

Technical Support 

The Technical Support of Siemens Industry provides you fast and competent 
support regarding all technical queries with numerous tailor-made offers – ranging 
from basic support to individual support contracts. 

You send queries to Technical Support via Web form:  
www.siemens.en/industry/supportrequest . 

Service offer 

Our range of services includes, inter alia, the following:  

6. Product trainings 

7. Plant data services 

8. Spare parts services 

9. Repair services  

10. On-site and maintenance services 

11. Retrofitting and modernization services 

12. Service programs and contracts  

You can find detailed information on our range of services in the service catalog: 
https://support.industry.siemens.com/cs/sc 

Industry Online Support app 

You will receive optimum support wherever you are with the "Siemens Industry 
Online Support" app. The app is available for Apple iOS, Android and Windows 
Phone: 
https://support.industry.siemens.com/cs/ww/en/sc/2067  
 

https://support.industry.siemens.com/
http://www.siemens.en/industry/supportrequest
https://support.industry.siemens.com/cs/sc
https://support.industry.siemens.com/cs/ww/en/sc/2067


0  
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10.2 Links and Literature  

Table 10-1 

No. Topic 

\1\ Siemens Industry Online Support 

https://support.industry.siemens.com 

\2\ https://support.industry.siemens.com/cs/ww/en/view/66579062 

 

10.3 History 

Table 10-2 

Version Date Change 

V1.0 03/2017  First version 

V 2.0 07/2017 Contents in respect of installation requirements, software 
installation, commissioning and troubleshooting expanded 

 

 

https://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/en/view/66579062

	Installation and Commissioning of Process Historian and Information Server in a PCS 7 Environment
	Warranty and liability
	Preface
	1 Introduction
	1.1 Overview
	1.2 PH / IS Installation sequence on a Fujitsu Primergy Server
	1.3 Components used

	2 Installation requirements
	2.1 Installation requirements for the Process Historian
	2.2 Installation requirements for the Information Server
	2.3 Installation requirements for the IS client
	2.3.1 Requirements for the Internet Explorer IS client
	2.3.2 Requirements for the Office IS client


	3 Server configuration
	3.1 Calculation of the HW requirements with the PH HW Advisor
	3.2 Hardware RAID configuration
	3.3 Software RAID configuration
	3.3.1 Initialization
	3.3.2 Start RAID configurator
	3.3.3 RAID1 configuration for the operating system
	3.3.4 RAID1 configuration for the archive data
	3.3.5 RAID10 configuration for the message data

	3.4 Installation of the operating system
	3.4.1 Initialization
	3.4.2 Selection of operating system
	3.4.3 Defining the operating system partitioning
	3.4.4 Operating System Settings
	3.4.5 Installation
	3.4.6 Finishing the installation

	3.5 Partitioning the hard disks
	3.5.1 Preparing for calibration
	3.5.2 Performing the partitioning
	3.5.3 Subsequent modification of the hard disk name
	3.5.4 Expansion of the operating system partition
	3.5.5 Display of too little unpartitioned storage space
	3.5.6 Aligning the disk names


	4 Installing the Process Historian / Information Server
	4.1 Installation of system components required for the Process Historian
	4.1.1 Installing Message Queuing
	4.1.2 Installation Microsoft.NET framework version 3.5

	4.2 Installation of system components required for the Information Server
	4.2.1 Installation of the Internet Information Server

	4.3 Internet Explorer 11 settings for the Information Server
	4.4 Creating a backup copy
	4.5 Installation of the Process Historian and Information Server
	4.6 Notes on Process Historian Database Segmentation
	4.7 Executing the Database Installation Wizard
	4.8 Configuring the PH redundancy service
	4.9 Installation of the Information Server within Internet Explorer
	4.10 Installing an Information Server client
	4.10.1 Web Information Server Client installation
	4.10.2 Installing an MS Office IS client


	5 Installation of the Operator Station
	5.1 Installation procedure for the "OS Server for Process Historian"
	5.2 Installation procedure for the "OS Single Station for Process Historian"
	5.3  Installing the "ProcessHistorian Ready" component

	6 Software update installation
	7 PH engineering in a PCS 7 project
	8 Commissioning
	8.1 Sequence for initial commissioning
	8.2 Redundant OS server
	8.3 Process Historian
	8.4 Information server

	9 Troubleshooting / System checking
	9.1 Manually call up the installation wizard for the PH database
	9.2  Invoking the Configuration Wizard manually for the IS
	9.3 Checking the OS installation for PH Ready
	9.4 Checking the PH installation
	9.5  Checking the MS Reporting Services
	9.6 Log files
	9.7  Starting the PHControl Message Queue
	9.8 IS client message "You are using outdated browser. Please update your browser"
	9.9 Microsoft.NET Framework 4.0
	9.9.1 Checking the registration of Microsoft.NET Framework 4.0
	9.9.2 Registering Microsoft.NET Framework manually

	9.10 Checking the Internet settings of the IS server

	10 Appendix
	10.1 Service and Support
	10.2 Links and Literature
	10.3 History


